Dearborn Protocol Adapter
DPA 5 Series

Installation and User Manual

Driver Version: 1.26
Native Drivers Version: 10.05
DPA 5 Dual CAN / Bluetooth Firmware Version: 65.110
DPA 5 Quad-CAN Firmware Version: 67.109
DPA 5 J2534 Drivers Version: 1.0.24.0
DPA Utilities: 1.17

© 2012 Dearborn Group, Inc.
Permission is granted to copy any or all portions of this manual, provided that such copies are for use with the DPA product and that “© 2012 Dearborn Group, Inc.”, (herein referred to as “Dearborn Group”, “DG Technologies”, or “DG”), remains on all copies.

The accompanying software, provided for use with the DPA 5, is also copyrighted. Permission is granted to copy this software for back-up purposes only.

**IMPORTANT**

To ensure your success with this product, it is essential that you read this document carefully before using the hardware. Damage caused by misuse of the hardware is not covered under product warranty.

When using this manual, please remember the following:

- This manual may be changed, in whole or in part, without notice.
- DG assumes no responsibility for any damage resulting from the use of this hardware and software.
- Specifications presented herein are provided for illustration purposes only and may not accurately represent the latest revisions of hardware, software or cabling.
- No license is granted, by implication or otherwise, for any patents or other rights of DG or of any third party.

The “DG” logo is a registered trademark of Dearborn Group, Inc. Other products that may be referenced in this manual are trademarks of their respective manufacturers.

The DPA Product line has been awarded the following U.S. Patents:

<table>
<thead>
<tr>
<th>Patent #</th>
<th>Date</th>
<th>Patent Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>6,772,248</td>
<td>08-03-04</td>
<td>Protocol adapter for in-vehicle networks.</td>
</tr>
<tr>
<td>7,152,133</td>
<td>12-19-06</td>
<td>Expanded functionality protocol adapter for in-vehicle networks.</td>
</tr>
<tr>
<td>7,337,245</td>
<td>02-26-08</td>
<td>Protocol Adapter for Passing Diagnostic Messages between Vehicle Networks and a Host Computer.</td>
</tr>
<tr>
<td>7,725,630</td>
<td>05-25-10</td>
<td>Protocol adapter for passing diagnostic messages between a host computer and vehicle networks operating in a J1939 or J1708 protocol.</td>
</tr>
</tbody>
</table>

DG Technologies
33604 West Eight Mile Road
Farmington Hills, MI 48335
Phone (248) 888-2000
Fax (248) 888-9977
www.dgtech.com
sales@dgtech.com
techsupp@dgtech.com
# Table of Contents

## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. SAFETY FIRST</td>
<td>5</td>
</tr>
<tr>
<td>2. INTRODUCING THE DPA 5</td>
<td>6</td>
</tr>
<tr>
<td>2.1. RP1210 OEM SOFTWARE COMPATIBILITY</td>
<td>6</td>
</tr>
<tr>
<td>2.1. J2534 OEM SOFTWARE COMPATIBILITY</td>
<td>7</td>
</tr>
<tr>
<td>2.2. STANDARDS AND PROTOCOLS SUPPORTED</td>
<td>8</td>
</tr>
<tr>
<td>2.3. SYSTEM REQUIREMENTS</td>
<td>9</td>
</tr>
<tr>
<td>2.4. SINGLE-APPLICATION VERSUS MULTI-APPLICATION DRIVERS</td>
<td></td>
</tr>
<tr>
<td>3. GETTING STARTED WITH THE DPA (STEPS 1-4 OF 6)</td>
<td>10</td>
</tr>
<tr>
<td>3.1. DRIVER INSTALLATION</td>
<td>10</td>
</tr>
<tr>
<td>3.2. CONNECT USB CABLE TO THE DPA AND THEN TO PC</td>
<td>11</td>
</tr>
<tr>
<td>3.1. CONNECT VEHICLE-SIDE CABLE TO THE DPA</td>
<td>11</td>
</tr>
<tr>
<td>3.2. CONNECT VEHICLE-SIDE CABLE TO THE VEHICLE</td>
<td>11</td>
</tr>
<tr>
<td>4. FINALIZE PC INSTALL (STEP 5 OF 6)</td>
<td>12</td>
</tr>
<tr>
<td>4.1. FINALIZE PC INSTALL ON WINDOWS 2000, XP, VISTA OR 7 32-BIT</td>
<td>12</td>
</tr>
<tr>
<td>4.2. FINALIZE PC INSTALL ON VISTA OR 7 64-BIT</td>
<td>13</td>
</tr>
<tr>
<td>5. AUTOMATIC FIRMWARE UPDATE (STEP 6 OF 6)</td>
<td>14</td>
</tr>
<tr>
<td>6. SETTING UP YOUR RP1210-COMPLIANT OEM DIAGNOSTIC APPLICATIONS</td>
<td>15</td>
</tr>
<tr>
<td>6.1. NOTES ON SELECTING AN RP1210 COMPLIANT ADAPTER</td>
<td>15</td>
</tr>
<tr>
<td>6.2. CONFIGURING APPLICATIONS TO USE THE DPA 5</td>
<td>15</td>
</tr>
<tr>
<td>6.3. ALLISON DOC</td>
<td>15</td>
</tr>
<tr>
<td>6.4. BENDIX ABS DIAGNOSTICS</td>
<td>16</td>
</tr>
<tr>
<td>6.5. CATERPILLAR ELECTRONIC TECHNICIAN</td>
<td>16</td>
</tr>
<tr>
<td>6.6. CUMMINS INSITE</td>
<td>16</td>
</tr>
<tr>
<td>6.7. DETROIT DIESEL DIAGNOSTIC LINK V7</td>
<td>16</td>
</tr>
<tr>
<td>6.8. DANA DIAGNOSTIC TOOL 2.X.X.</td>
<td>17</td>
</tr>
<tr>
<td>6.9. EATON SERVICE RANGER 3.X.X.</td>
<td>17</td>
</tr>
<tr>
<td>6.10. FREIGHTLINER SERVICE LINK</td>
<td>17</td>
</tr>
<tr>
<td>6.11. INTERNATIONAL TRUCK AND ENGINE</td>
<td>17</td>
</tr>
<tr>
<td>6.12. MERITOR-WABCO ABS TOOLBOX</td>
<td>18</td>
</tr>
<tr>
<td>6.13. VOLVO/MACK VCADS PRO</td>
<td>19</td>
</tr>
<tr>
<td>6.14. VOLVO/MACK PREMIUM TECH TOOL (PTT)</td>
<td>19</td>
</tr>
<tr>
<td>7. SETTING UP YOUR J2534-COMPLIANT OEM APPLICATIONS AND DPA 5</td>
<td>20</td>
</tr>
<tr>
<td>8. TROUBLESHOOTING / VALIDATING YOUR DPA WITH ADAPTER VALIDATION TOOL</td>
<td>21</td>
</tr>
<tr>
<td>8.1. CONNECTION-RELATED ISSUES</td>
<td>21</td>
</tr>
<tr>
<td>8.2. NOT SEEING DPA IN OEM APPLICATION VDA SELECTION LIST</td>
<td>24</td>
</tr>
<tr>
<td>8.3. USB-RELATED ISSUES</td>
<td>25</td>
</tr>
<tr>
<td>8.4. ADVANCED TESTING DIALOG</td>
<td>25</td>
</tr>
<tr>
<td>9. J2534 - TROUBLESHOOTING YOUR DPA</td>
<td>27</td>
</tr>
<tr>
<td>9.1. CONNECTION-RELATED ISSUES</td>
<td>27</td>
</tr>
<tr>
<td>9.2. USB-RELATED ISSUES</td>
<td>29</td>
</tr>
<tr>
<td>10. DPA OPTIONS PROGRAM</td>
<td>30</td>
</tr>
<tr>
<td>10.1. DPA OPTIONS VERSION 2.0 NOTES; RP1210 DPA DRIVER SETS</td>
<td>30</td>
</tr>
<tr>
<td>10.2. SET OPTIONS FOR DPA DEVICE/API</td>
<td>31</td>
</tr>
<tr>
<td>10.3. J1939 FAST TRANSPORT LAYER (FAST_TRANSPORT OPTION)</td>
<td>31</td>
</tr>
</tbody>
</table>
1. Safety First

It is essential that the user read this document carefully before using the hardware.

The DPA 5 device is to be used by those trained in the troubleshooting and diagnostics of light-duty through heavy-duty vehicles. The user is assumed to have a very good understanding of the electronic systems contained on the vehicles and the potential hazards related to working in a shop-floor environment.

DG understands that there are numerous safety hazards that cannot be foreseen, so we recommend that the user read and follow all safety messages in this manual, on all of your shop equipment, from your vehicle manuals, as well as internal shop documents and operating procedures.

- Always block drive, steer, and trailer wheels both front and back when testing.
- Use extreme caution when working around electricity. When diagnosing any vehicle, there is the risk of electric shock both from battery-level voltage, vehicle voltages, and from building voltage.
- Do not smoke or allow sparks or open flames near any part of the vehicle fueling system or vehicle batteries.
- Always work in an adequately ventilated area, and route vehicle exhaust outdoors.
- Do not use this product in an environment where fuel, fuel vapor, exhaust fumes, or other potentially hazardous liquids, solids, or gas/vapors could collect and/or possibly ignite, such as in an unventilated area or other confined space, including below-ground areas.
2. Introducing the DPA 5

The DPA 5 products are used to connect vehicle communication networks to personal computers (PCs). This allows programs written for the PC to retrieve pertinent vehicle information such as fault codes, component information, as well as perform vehicle and component level diagnostics, tests, and component reprogramming. The DPA 5 devices communicate with the PC using either a USB cable or via Bluetooth (Class I or Class II), and comes standard with Technology and Maintenance Council (TMC) Recommended Practice (RP) RP1210B-compliant drivers, as well as Society of Automotive Engineers (SAE) J2534-compliant drivers.

![DPA 5 with Dual CAN Channels with Bluetooth Communications](image1)

![DPA 5 with Quad CAN Channels No Bluetooth Communications](image2)

The DPA 5 Dual-CAN / Bluetooth device is the most commonly sold DG DPA 5 product. This manual is geared more to this product; however, the concepts also apply to the DPA 5 Quad-CAN. Distinctions will be made as appropriate.

Before switching communications modes from USB to Bluetooth and vice-versa, the DPA 5 Dual-CAN / Bluetooth must be powered off and then back on.

2.1. RP1210 OEM Software Compatibility

The adapter you have purchased is provided with a Technology and Maintenance Council (TMC) RP1210B compliant (backwards compatible with RP1210A) interface and has been validated against the following OEM and component applications:

- Allison DOC™
- Bendix® ACOM
- Caterpillar® Electronic Technician
- Cummins® Insite™
- Cummins PowerSpec™
- Dana Diagnostic Tool™
- Detroit Diesel Diagnostic Link™
- Detroit Diesel Reprogramming Station™
- Eaton ServiceRanger
- Freightliner ServiceLink
- International® Diamond Logic Builder
- International® InTune
- International® Master Diagnostics
- International® ServiceMaxx
- Mack and Volvo VCADS/PTT
- Meritor-WABCO Toolbox
- Vansco VMMS
- ZF-Meritor TransSoft

Any application claiming RP1210A or RP1210B compliance should work if the application and adapter both support the same protocol(s) and operating system(s). 

© 2012 Dearborn Group, Inc.
2.1. J2534 OEM Software Compatibility

The adapter you have purchased is provided with an SAE J2534-compliant interface (an SAE standard for electronic module reprogramming – sometimes call the “Pass Thru Programming” standard). The DPA 5 should be able to reprogram all CAN/ISO15765 vehicles, GM vehicles using the J1850 Variable Pulse Width (VPW) protocol, or other vehicles using the DPA 5 J2534-supported protocols (i.e. ISO9141/KWP2000).

The DPA 5 has been validated against the following OEM and component applications:

- General Motors TIS2Web
- Ford Module Programming (FMP)
- Chrysler J2534 Application
- Toyota TIS (Technical Information System)
- Honda Service Express
- Mazda Module Programming (MMP)
- Kia J2534 KMA
- Hyundai 2534 HMA
- Volkswagen Erwin
- Audi Erwin
- Nissan J2534 ECU Reprogramming Software (NERS)

All J2534 reprogramming and diagnostic software packages that are J2534-1 and J2534-2 compliant and use a protocol supported by the DPA 5 should work as long as the operating system is supported by the application. Note that not all OEMs have released J2534-2 compliant software.

2.2. Standards and Protocols Supported

The adapter you have purchased provides more protocol and standards support than any other commercially available diagnostic adapter.

2.2.1. Operating Systems and Standards Supported

- Operating Systems
  - Windows 2000®
  - Windows XP®
  - Windows Vista® 32-bit and 64-bit Versions
  - Windows 7® 32-bit and 64-bit Versions
- TMC RP1210B, TMC RP1210A
- SAE J2534-1, J2534-2
- CE Certification
- Vehicle Electronic Programming Station (VEPS) J2214/J2461

2.2.2. RP1210 Defined Protocols Supported

- J1939
- J1708/J1587
- J1850 GM (Class 2)
- ISO 9141-2
- ISO 14230 (KWP2000)
- CAN (ISO11898)
- CAN@500k/J2284/GMLAN
  - The IESCAN protocol name is also CAN@500k.
2.2.3. J2534 Defined Protocols Supported

- CAN (Raw CAN)
- J1850 VPW (GM Class II)
- ISO 15765-4
- GMLAN (HSCAN, SWCAN)
- ISO 14230 (KWP2000)
- ISO 9141-2
- J1708/J1587
- J1939

2.2.4. Additional Protocols Supported by Native Drivers

- J2411 (GM SWCAN)
- ALDL

2.3. System Requirements

If you are not familiar with selecting a PC for your diagnostic applications, we recommend starting with a computer compatible with the latest version of the TMC RP1208 (PC Selection Guidelines for Service Tool Applications).

In addition to the aforementioned document, the following items are recommended or required.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>IBM-Compatible</td>
</tr>
<tr>
<td>Processor</td>
<td>1GHz or Faster</td>
</tr>
<tr>
<td>RAM</td>
<td>256MB (512MB Preferred)</td>
</tr>
<tr>
<td>USB Port</td>
<td>USB Version 1.1 or Higher</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 2000</td>
</tr>
<tr>
<td></td>
<td>Windows XP</td>
</tr>
<tr>
<td></td>
<td>Windows Vista (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 (32-bit or 64-bit)</td>
</tr>
</tbody>
</table>
2.4. Single-Application versus Multi-Application Drivers

This release of the DPA 5 drivers does not support multiple OEM applications running simultaneously.

- This release includes what are called the DPA 5 “single application” drivers, named **DGDP5SA** and will appear in OEM applications as Dearborn Group DPA 5 Single Application.

- A future release will include the DPA 5 multi-application drivers which will be named **DGDP5MA** and will appear as Dearborn Group DPA 5 Multi Application in OEM applications.

It has been DG’s experience that when several OEM applications are running simultaneously, especially on a crowded J1939 data bus, they sometimes miss critical timing events and messages. As a result applications do not behave as they would normally. Therefore, DG will be installing the single-application drivers as well as the multi-application drivers (when they are released) separately since the single-application drivers are faster and require less PC resources. Another note is that OEM applications are generally not tested with other applications running at the same time.

---

| Use Single Application Drivers If Possible… | Because of the added overhead and resources involved with handling multiple OEM applications simultaneously, DG recommends that you use the **DGDP5SA** single application drivers as much as possible. They are a much better choice for time-critical applications such as reflashing and diagnostic tests (i.e. cylinder cutout). Use the **DGDP5MA** drivers only as necessary such as when needing to run an engine application alongside a transmission application; or when needing to record vehicle data with one program while running an OEM application. |
---|---|

Page 9 of 49 © 2012 Dearborn Group, Inc.
3. Getting Started with the DPA (Steps 1-4 of 6)

If you ordered the DPA 5 as part of a kit, it should include the following items:

- Rugged Plastic Carrying Case
- DPA 5 Diagnostic Tool
- 6-pin/9-pin Deutsch Connector “Y” Cable, for vehicle-side connection
  - The cable supports two CAN channels (configured for the Freightliner Cascadia)
- USB Cable, gold-plated with screw-in ears to secure the cable to the DPA 5 case
- DPA 5 Installation Disc
- Printed Quick Start Sheet
- Bluetooth PC dongle (if a Bluetooth kit was purchased)

Please note that DG Technologies does customize our kits for our vendors, so what you receive may vary.

3.1. Driver Installation

Attention!

- Install DPA drivers from CD before connecting DPA to your PC.
- To install drivers you must be logged into the administrator account or have administrator privileges.
- If you run into problems installing the drivers or the DPA, please do not hesitate to contact technical support at (248) 888-2000.

Attention!

The DPA drivers provided on the installation CD are installed by inserting the disc into your PC’s CD-ROM drive. The latest drivers and firmware are always available at www.dgtech.com/download.php. If you have any questions about the install, please contact our technical support staff.

If setup does not begin automatically, use the following sequence for Windows 2000 and XP:

Start ➔ Run ➔ [CD_Drive_Letter]:\DPA5Install.exe and click OK
If setup does not begin automatically, use the following sequence for Windows Vista or Windows 7:

Start ➔ All Programs ➔ Accessories ➔ Run ➔ [CD_Drive_Letter]\DPA5Install.exe and click OK

After the drivers are installed, you will be prompted to restart your computer. While your PC is rebooting, continue following the next instructions.

3.2. Connect USB Cable to the DPA and Then to PC

Remove the sticker covering the USB port and connect the USB cable to the DPA and PC. The USB cable that comes with the DPA 5 has ears that allow the cable to be screwed into standoff screws on the DPA 5 frame, greatly reducing the chance of breaking the USB connector on the DPA circuit board.

PC-side USB Cable

3.1. Connect Vehicle-Side Cable to the DPA

Connect the vehicle-side of the cable (the DB26 connector) to your DPA before you connect to the vehicle (see the note below). Do not connect to vehicle first!

Vehicle-side Cable

6-pin/9-pin Deutsch “Y” Cable (Heavy-Duty)

3.2. Connect Vehicle-Side Cable to the Vehicle

Now, connect the DPA to the vehicle, verifying that the DPA Power LED is lit.
4. **Finalize PC Install (Step 5 of 6)**

This step differs depending on which version of Microsoft Windows you are installing on.

### 4.1. Finalize PC Install on Windows 2000, XP, Vista or 7 32-bit

If you are installing on either Vista or Windows 7 64-bit, go to section 5.2 **Finalize PC Install on Vista or 7 64-bit**.

The DPA is now connected to the PC and powered on. In some versions of Windows the final step in driver installation is automatic. In others, the Windows Found New Hardware Wizard will run to finalize driver installation. What appears in Windows XP is shown below.

Select **Install the software automatically (Recommended)** and press the **Next** button.

This screen appears while Windows installs the drivers.

This screen appears when Windows has finished installing the drivers. Press the **Finish** button. Your DPA drivers have been installed successfully.
4.2. Finalize PC Install on Vista or 7 64-bit

4.2.1. 64-bit Vista and Windows 7 installed successfully

After installing on Vista or Windows 7, simply plug the DPA 5 into the PC via the USB cable. The DPA 5 is powered on. The following screen will display in the lower right corner for about five seconds.

Followed by this screen. Your DPA 5 is now ready for use.
5. **Automatic Firmware Update (Step 6 of 6)**

When a DPA PC drivers release is made, a specific set of DPA firmware is validated with that release. In this release the firmware that was validated can be found on the cover page of this manual.

**DG strongly recommends that users keep their DPA up-to-date with the latest firmware revision.**

*Automatic Firmware Update* is an option that is most likely turned **On** in your installation. Some customers receive special drivers where this is not the case, however this paragraph assumes that this option is turned on, and set to a value of 1. To learn more about this option, see the chapter entitled **Modifying DPA Settings – DPA Options Program.**

After you have finished installing the Windows device drivers (Step 5 of 6) you can begin using your DPA. If the *Automatic Firmware Update* option is on (by default, it is), every time you connect to the DPA, the drivers check to see if a newer version of firmware is available on the hard drive. If a newer version is available the user will be prompted (see Figure 6.1) to upgrade to that version. If the user selects **Yes**, the upgrade process begins automatically. When the upgrade process is complete, the connect sequence for that application will continue. Most applications can handle the delay; however there is a possibility that the user may have to restart their application.

The following is the dialog box that will be displayed if out-of-date firmware is detected. We recommend pressing **Yes** and upgrading.

![DPA Firmware Requires Updating](image)

*Figure 6.1. DPA Firmware Out of Date Dialog Box*
6. Setting Up Your RP1210-Compliant OEM Diagnostic Applications

The DPA works with all RP1210A and RP1210B compliant applications that support J1708/J1587, CAN/J1939, J1850 VPW (GM Class II) and the ISO15765 protocols. The DPA also works with applications that were specifically written to use the DG non-RP1210-compliant native drivers for other protocols, such as GM UART and ISO9141. This section shows how to configure the most common RP1210-compliant diagnostic applications to work with the DPA 5.

6.1. Notes on Selecting an RP1210 Compliant Adapter

Selecting a RP1210 adapter, commonly referred to as a Vehicle Datalink Adapter (VDA) varies widely from application to application; however, the terminology remains pretty much the same. The following table helps to introduce you to the terminology and helps you to make the correct selections the first time.

You must set up every application (in their own individual way) to use the DPA!

<table>
<thead>
<tr>
<th>If You See These Terms</th>
<th>Select This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor API</td>
<td>Dearborn Group DPA 5 Single Application</td>
</tr>
<tr>
<td>API</td>
<td>Or DGDPA5SA</td>
</tr>
<tr>
<td>DLL</td>
<td></td>
</tr>
<tr>
<td>Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Adapter Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Device Name</td>
<td>DG DPA 5 Dual-CAN USB, USB</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth, Wireless</td>
</tr>
<tr>
<td>Device Number</td>
<td></td>
</tr>
<tr>
<td>DeviceID</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Or Bluetooth Wireless DeviceID</td>
</tr>
<tr>
<td>Protocol (Depends on Application)</td>
<td>Most Commonly Encountered:</td>
</tr>
<tr>
<td></td>
<td>✓ J1708 (J1708/J1587)</td>
</tr>
<tr>
<td></td>
<td>✓ J1939</td>
</tr>
<tr>
<td></td>
<td>✓ ISO15765</td>
</tr>
<tr>
<td></td>
<td>✓ CAN</td>
</tr>
</tbody>
</table>

6.2. Configuring Applications to Use the DPA 5

The following examples show how to select your DPA 5 device using the USB cabling method. Bluetooth device entries are based on the DPA 5 Bluetooth ID (see Bluetooth appendix).

6.3. Allison DOC

1. Start program.
2. Click **Connect to Vehicle**.
3. Select the Correct Transmission Type.
4. Uncheck **Smart Connect**.
5. Click **Connect**.
6. Click **Advanced Setup**.
7. Select vendor of **Dearborn Group DPA 5 Single Application**.
8. Select protocol of **J1939** or **J1708**.
9. Select correct device of **DPA 5 Dual CAN USB** (or **DPA 5 #[DPA 5 Bluetooth ID]** Bluetooth).
10. Click **OK**.
6.4. **Bendix ABS Diagnostics**

NOTE: DO NOT RUN Bendix ABS Diagnostics until you have done the following:

1. Start program.
2. If *Diagnostic Interface Selection* dialog box does not appear, click on *Vehicle Interface Adapter* icon.
   a. Select *RP1210A Device Using J1708 Line:* DPA 5 Dual CAN USB (or DPA 5 DPA 5 Bluetooth ID Bluetooth).
3. Click OK.

6.5. **Caterpillar Electronic Technician**

1. Start Program.
2. Click Utilities ➔ Preferences ➔ Communications from the menu bar.
3. Click on *Communication Interface Device* dropdown box.
4. Select RP1210 Compliant Device.
5. Click Advanced
6. Select *DPA 5 Dual CAN USB* (or *DPA 5 Bluetooth ID Bluetooth*) in the RP1210 Communication Adapter Device box.
7. Click OK
8. Check *Enable Dual Data Link Service*
9. Click OK.

6.6. **Cummins Insite**

1. Start Program.
2. Click on File ➔ Connections ➔ Add New Connection.
3. Click Next.
4. Click radio button for *Datalink Adapter* and click Next.
5. Select correct device *DPA 5 Dual CAN USB* (or *DPA 5 Bluetooth ID Bluetooth*), and protocol you want to use, J1708/J1939.
6. Click Next and a Connection Name screen appears.
7. Click Next and a screen prompts you to indicate whether you want to make this connection active or set up another connection.
8. Click on *make this connection active*.
9. Click Finish.

6.7. **Detroit Diesel Diagnostic Link V7**

6.7.1. **From Windows Start Menu**

1. Start ➔ Programs ➔ Detroit Diesel ➔ Diagnostic Link ➔ SID configure
2. Select *DPA 5 Dual CAN USB* (or *DPA 5 Bluetooth ID Bluetooth*).
3. Click OK.

6.7.2. **From Inside DDDL**

1. Tools ➔ Options ➔ Connections Tab ➔ SID Configure.
2. Select *DPA 5 Dual CAN USB* (or *DPA 5 Bluetooth ID Bluetooth*).
3. Click OK.
6.8. Dana Diagnostic Tool 2.x.x

1. Start program
3. Select Connect J1708 or Connect J1939 or Connect PLC as appropriate for your controller.

6.9. Eaton ServiceRanger 3.x

1. Start Program
2. Click Tools ➔ Settings ➔ Connection.
3. Under Driver choose Dearborn Group DPA 5 Single Application
4. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth) for both the J1708 and J1939 device.
5. Click OK.

6.10. Freightliner ServiceLink

1. Start program.
2. From the top menu bar, choose Admin.
3. From the left menu bar, choose Vehicle.
4. Click on Show All Devices.
5. In the Vendor box, choose Dearborn Group DPA 5 Single Application.
6. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth) in the J1939 and J1708 drop down items.
7. In the CAN Device item, select the Configure button and choose DG DPA 250K CAN Ch2 USB,USB from the SID Configuration window.
8. Click Save Settings.

6.11. International Truck and Engine

6.11.1. Master Diagnostics (MD Fleet)

1. Start program.
2. Choose File ➔ MD Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Single Application ➔ Window with specific port DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

6.11.2. Navistar Hydraulic ABS

1. Start program.
2. Choose File ➔ Hydraulic ABS Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Single Application ➔ Window with specific port DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).
6.11.3. Navistar IPC

1. Start program.
2. Choose File → Settings → COM Device → Window with general VDA selection
3. Select Dearborn Group DPA 5 Single Application → Window with specific port DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

6.11.4. Diamond Logic Builder (DLB)

1. Start program.
2. Choose Tools → Select Com Link → Listing of adapters
3. Select Dearborn Group DPA 5 Single Application → Listing of ports DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

6.11.5. Service Assistant (The new MD Fleet)

1. Start program.
2. Press third button from the top along the left side (has an icon that looks like a miniature interface cable.)
   a. A window comes up that says Communication Device Selection and has two drop down boxes.
   b. Select Dearborn Group DPA 5 Single Application → DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

6.12. Meritor-WABCO ABS Toolbox

1. Start Program.
2. Click System Setup; then select COM Port.
3. Select Dearborn Group DPA 5 Single Application; the protocol to use is J1939 or J1708.
4. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth) and click OK.
6.13. Volvo/Mack VCADS Pro

6.13.1. From Initial VCADS Setup

1. When prompted to configure a Communication Unit select **RP1210A adapter**.
2. When prompted for the adapter, select **DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth)**.
3. Select **USB** for the Port.
4. Select **J1708** for the protocol.
5. When prompted for the Electrical Systems.
   a. Click **Volvo Trucks – VERSION2** and select **RP1210A Adapter**
   b. Click **Volvo Trucks – Vehicle electronics ’98** and select **RP1210A Adapter**
   c. Click **Mack Trucks – V-MAC I/II/III, ITC** and select **RP1210A Adapter**
   d. Click **Volvo Trucks – V-MAC IV** and select **RP1210A Adapter**
6. Continue with installation.

6.13.2. From Inside VCADS

1. Start Program.
2. Click the **Tools** menu and choose **Options**.
3. Select the **Comm. Unit Configuration** tab.
4. Select **RP1210A Adapter** and then select **DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth)**.
5. Select **USB** for the Port.
6. Select **J1708** for the protocol.
7. Go to the **Comm. Unit Selection** tab.
   a. Click **Volvo Trucks – VERSION2** and select **RP1210A Adapter**
   b. Click **Volvo Trucks – Vehicle electronics ’98** and select **RP1210A Adapter**
   c. Click **Mack Trucks – V-MAC I/II/III, ITC** and select **RP1210A Adapter**
   d. Click **Volvo Trucks – V-MAC IV** and select **RP1210A Adapter**
8. Click **Ok**.


1. Start Program.
2. Select Settings from the PTT menu.
3. Go to the Communication Unit configuration tab:
   a. It is here that you select the settings for each adapter that you may use. For example, if you have an RP1210A adapter, it is here that you select which adapter, port, and protocol.
   b. **NOTE:** This identifies the settings for each adapter. It does not select which adapter the PTT application will use to communicate with the vehicle.
4. Go to the Comm unit selection tab:
   a. It is here that you identify which adapter is to be used by the PTT application to communicate with the vehicle. You may have to change this selection depending upon the vehicle.
   b. For example, if you typically use an 88890020 adapter in direct mode, when you need to communicate with an older vehicle you will need to change to RP1210A adapter or the 9998555 adapters, depending upon the vehicle.
7. Setting Up Your J2534-Compliant OEM Applications and DPA 5

Setting up and reflashing of a component using a J2534-compliant OEM application is a very lengthy process and is out of the scope of this manual. For more information, you can refer to the OEM application documentation or you can download the OEM application reflashing guide from the Dearborn Group VSI-2534 device downloads page.

In general, there will be a screen that will appear that allows a user to select a J2534-compliant Vendor and Device for the reflashing event. When you see this type of screen, choose Dearborn Group, Inc. and/or the DPA 5.

![The General Motors TIS2Web - J2534 Application VDA selection screen.](image-url)
8. **Troubleshooting / Validating Your DPA with Adapter Validation Tool (AVT)**

If your OEM diagnostic application is having trouble using the DPA after following the instructions for configuring that application in Chapter 6, you can use the DG Adapter Validation Tool (AVT) to troubleshoot the DPA and validate that the DPA drivers are installed properly, the PC can communicate with the DPA, and the DPA can see message traffic on the data bus that your OEM diagnostic application is trying to use.

- Most DPA technical support calls about OEM applications not working come from users who have not configured that OEM application to use the DPA (see Chapter 6), or who have selected the incorrect protocol.
  - The quick rule of thumb for selecting a protocol is the type of connector you are connecting to:

<table>
<thead>
<tr>
<th>Connector Type</th>
<th>Protocol Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1708 Connector (6-pin Deutsch)</td>
<td>This connector only has the J1708/J1587 protocol.</td>
</tr>
<tr>
<td>J1939 Connector (9-pin Deutsch)</td>
<td>OEMs switched to this connector when they moved to J1939. J1708 may not be available.</td>
</tr>
</tbody>
</table>

There are typically three problem areas with RP1210 VDA devices. Each problem is discussed in the following sections:

**8.1. Connection-Related Issues**

After you have followed the instructions in this manual to install the DPA drivers, connect the DPA to the vehicle and ensure the **Power LED** is on. Then connect it to the PC and listen for the familiar "Da Ding" "USB device found" sound. If you cannot hear this sound, the PC cannot communicate with the DPA and you will most likely end up not being able to get AVT to be successful. Try another USB port until you hear that sound.

Run AVT either from the **Adapter Validation Tool** link on your desktop, or from the **Start Programs** menu.

![AVT Interface](image)
Select the DPA 5 Dual-CAN / Bluetooth device (or DPA 5 Quad-CAN):

- **Vendor**: DGDPA5SA - Dearborn Group DPA 5 Single Application
- **Device**: 1 – DG DPA 5 Dual-CAN USB – USB
  
  2 – DG DPA 5 Quad-CAN USB – USB
- **Protocol**: J1708 or J1939 (depending on your application)

Then click the Run Test button. Depending on the results of the test, both the **RP1210 Status Window** and **RP1210 Data Message Window** will turn **green** (pass) or **red** (fail).

### 8.1.1. AVT Test Outcomes

If the **RP1210 Status Window** turns **red**, then there is a problem causing the PC not to communicate with the DPA. This may be something as simple as having power to the DPA or a USB issue. Disconnect the DPA from the vehicle and PC; then reconnect them, this time connecting to another USB port on the PC.

If the **RP1210 Status Window** turns **green** and the **RP1210 Data Message Window** turns **red**, then the PC is seeing the DPA, but not seeing messages from the data bus. Check the vehicle ignition switch and vehicle to adapter cabling. Disconnect the DPA from the vehicle and PC; then reconnect them.

If you see data in the **RP1210 Data Message Window**, your DPA is installed and functioning properly! Refer to Chapter 6 on how to configure your OEM application to use the DPA.

Read the **Test Results Discussion and Next Steps** screen carefully and follow those directions to help diagnose where the issue may be. If, after reading and following those instructions, you cannot get the DPA working, please contact DG technical support.

- Many DPA technical support calls could have been avoided by following the instructions on the **Test Results Discussion and Next Steps** screen.

### 8.1.2. Good Connection (PC to DPA), Good Read of Data (DPA to Vehicle) – Green/Green

The above screen snapshots show the PC successfully connecting to the DPA (RP1210 Status Window) and the successful reading of data bus data (RP1210 Data Message Window) from the J1939 data bus.

- A Green/Green result indicates the DPA is working perfectly and is seeing data on the data bus. The area to work on is configuring the OEM application to use the DPA (see Chapter 6).
8.1.3. Good Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Green/Red

The above screen snapshots show the PC successfully connecting to the DPA (RP1210 Status Window) but AVT is not able to read data bus data (RP1210 Data Message Window) from the data bus selected (J1939).

- A Green/Red result indicates the DPA is working perfectly, but it is not seeing data on the data bus that was selected. Choose another protocol and check that the ignition switch is on.

8.1.4. Bad Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Red/Red

The above screen snapshots show the PC not connecting to the DPA (RP1210 Status Window).

- A Red/Red result indicates the PC is not seeing the DPA. Unplug DPA from vehicle and PC and reconnect to both using a different USB port. Ensure that you hear the “Dah Ding” sound. If you cannot hear the sound, reboot the PC and run AVT again. DG has been getting a lot of DPA technical support calls where OEM applications crash and keep the DPA device open.
8.2. Not Seeing DPA in OEM Application VDA Selection List

If you have installed the DPA drivers and can get AVT to a Green/Green outcome, you should be able to configure your diagnostic application to use the DPA. If your diagnostic application does not display **DG DPA 5 Dual-CAN, USB** in their VDA selection dialog box, this could indicate one of three things:

1. The application is not RP1210 compliant and does not work with the DPA.
   a. Some applications require a specific, proprietary adapter.

2. Application is RP1210 compliant, but DPA does not support the protocol needed.

3. Problem with the main RP121032 INI file.
   a. Some VDAs create issues with the RP121032 INI file when they install/uninstall.
   b. Many OEM diagnostic applications are aware of this issue and can read through the errors.

When the AVT software is launched, you will be told if a problem exists in the main RP121032 INI file. If you wish to fix this issue (**very highly recommended**), press the **Fix/Change RP121032.INI File** button on the main screen. If your PC is running Windows Vista or Windows 7, you will be prompted for administrator privileges. The following is the dialog box that will appear when AVT is launched and a problem is found in the main RP121032 INI file.

![Dialog box showing RP121032.INI file issue](image)

When you press the **Fix/Change RP121032.INI File** button, AVT will bring up a separate program called **Fix INI** that will allow you to view and fix the RP121032 INI file if there are errors detected. You can also change the VDA that appears first in the list of the OEM diagnostic software applications.

In the example below, a bad INI file was detected (depicted by a yellow background). Note the multiple commas and spaces between entries.

Click the **Make Changes** button and the INI file problem will be corrected. If you wish to make a specific adapter first in the list, you can select that vendor in the **Vendor to Make First in List** before pressing the **Make Changes** button.

![Fix INI dialog box](image)
The next picture shows the dialog box indicating that the INI file was fixed.

8.3. **USB-Related Issues**

If you plug in a DPA (or any other USB device) and get the New Hardware Found wizard, do not click cancel. Go through the wizard completely! **IF YOU SELECT Cancel, THE DPA WILL NOT WORK!**

Windows has many USB eccentricities that are generally solved by unplugging a device and then plugging that device back in. Sometimes you have to plug that device into another USB port.

8.4. **Advanced Testing Dialog**

With the J1939 data bus moving to 500k, there is a lot of RP1210 and J1939 committee focus on VDA vendors doing J1939 automatic baud detection to detect either a 250k or 500k J1939 data bus without creating issues. There is also a growing need for advanced testing on vehicles that have a second CAN data bus.

The DPA 5 API Supports the following commonly used RP1210_ClientConnect() modifications:

- Protocol:Baud=Auto
- Protocol:Baud=XXX
- Protocol:Channel=X
- Protocol:Baud=Auto;Channel=X
- Protocol:Baud=XXX;Channel=X

Pressing the **Advanced Test** button brings up the dialog box shown below.

8.4.1. **Vendor, Device, Protocol**

**Vendor, Device** and **Protocol** fields are the same as described in normal testing above.
8.4.2. Baud Rate Drop Down List Box

The **Baud Rate** drop down list box allows the user to select one of the supported protocol speeds for the selected protocol. The entries in this list box come from the VDA vendor’s INI file. Click the **Use Baud Rate** checkbox to activate a “Protocol:Baud=XXX” connection. If both the **Use Baud Rate** and **Use Channel** checkboxes are checked, then AVT will initiate a “Protocol:Baud=XXX;Channel=X” connection.

8.4.3. Channel Drop Down List Box

The **Channel** drop down list box allows the user to select one of the supported channels for the selected device. The entries in this list box come from the VDA vendor’s INI file. Click the **Use Channel** checkbox to activate a “Protocol:Channel=X” connection. If both the **Use Baud Rate** and **Use Channel** checkboxes are checked, then AVT will initiate a “Protocol:Baud=XXX;Channel=X” connection.

8.4.4. Vendor Supports CAN Auto Baud Checkbox

This checkbox indicates whether or not the API supports CAN (CAN, J1939, ISO15765) automatic baud detection. Even though this variable may be set to TRUE, the next four fields indicate whether the API supports Baud=XXX connect formats for CAN, J1939, and ISO15765. This field is just an informational field, and not all VDA vendors will support this feature.

8.4.5. Protocols Supporting Baud=XXX

These checkboxes indicate whether or not the API supports setting a specific baud rate (or automatic baud detection) for a specific protocol. These entries come from the VDA vendor’s INI file. These fields are just for informational purposes. Not all VDA vendors will support this feature.

8.4.6. Advanced Testing Commands – No Error Checking

When using this dialog box to initiate an advanced test, there is no error checking done to prevent the user from initiating a “Baud=XXX” or “Channel=X” connection to a VDA even if the vendor does not support that connection format.
9. J2534 - Troubleshooting Your DPA

There are typically three problem areas with J2534 VDA devices. Each problem is discussed in following sections:

9.1. Connection-Related Issues

After you have installed the DPA drivers and connected the DPA to both the PC and vehicle, make sure that the DPA Power LED is turned on. Run the J2534 Adapter Validation Tool (JVT) to ensure that the PC is able to communicate with the DPA, and that the DPA is able to see vehicle data bus traffic.

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 J2534 ➔ J2534 Validation Tool

Select the correct Device:

- Device: DPA 5 – Dearborn Group, Inc.
- Protocol: OBDII or Specific Protocol
  - Using the OBD II protocol selection means that JVT will attempt to connect using all OBD II protocols that the selected adapter supports (i.e. J1850VPW, ISO9141, ISO14230, ISO15765, etc) and with all OBD II options and OBD II speeds for that protocol (i.e. CAN 1Mb 11-bit, CAN 1Mb 20-bit, CAN 500Kb 11-bit, CAN 500Kb 29-bit, etc). DG recommends using the OBDII protocol setting initially since all vehicles after 1996 have to support an OBD II protocol.
  - You can also use a specific protocol (i.e. “CAN” as above), and JVT will connect using all speeds and options for that individual protocol.

Then click the Run Test button. Depending on the results of the test, both the J2534 Status Window and J2534 Data Message Window will turn green (pass) or red (fail).

9.1.1. JVT Test Outcomes

If the J2534 Status Window turns red, then there is a problem causing the PC not to communicate with the adapter. This may be something as simple as having power to the adapter or having a USB cabling issue. Disconnect the adapter from the vehicle and PC; then reconnect them, this time connecting to another USB port on the PC.

If the J2534 Status Window turns green and the J2534 Data Message Window turns red, then the PC is seeing the adapter, but not seeing messages from the vehicle. Check the vehicle ignition switch and vehicle to adapter cabling; disconnect the adapter from the vehicle and PC; then reconnect them.

If you see data in the J2534 Data Message Window, then the adapter is installed and functioning properly.
If after following the Test Results Discussion and Next Steps screen, you cannot get the adapter to read data, contact DG technical support.

9.1.2. Good Connection (PC to DPA), Good Read of Data (DPA to Vehicle) – Green/Green

The above screen snapshots show the PC successfully connecting to the DPA and the successful reading of data bus data from the CAN data bus. Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.

9.1.3. Good Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Green/Red

The above screen snapshots show the PC successfully connecting to the DPA but the application is not able to read data bus data from the data bus selected (CAN). Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.
9.1.4. **Bad Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Red/Red**

The above screen snapshots show the PC not able to connect to the DPA at all. Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.

9.2. **USB-Related Issues**

If you plug in a DPA (or any other USB device) and get the New Hardware Found wizard, do not click cancel. Go through the wizard completely! **IF YOU SELECT Cancel, THE DPA WILL NOT WORK!**
10. DPA Options Program

The DPA Options program allows you to set and configure various aspects of the DPA 5. The following sections describe the roles of the variables. The DPA 5 Bluetooth Configuration Utility is discussed later.

![DPA Options Version 2.0](image)

**10.1. DPA Options Version 2.0 Notes; RP1210 DPA Driver Sets**

Version 2.0 of DPA Options program adds the capability of modifying the settings for all DPA driver sets that are installed on your computer. Below is a table that briefly describes each driver.

<table>
<thead>
<tr>
<th>Driver Set</th>
<th>RP1210</th>
<th>Description</th>
</tr>
</thead>
</table>
| DG121032     | A      | DPA 4, 4 Plus and Prior DPAs (Single Application)  
              |        | Allows only one RP1210 application to run at a time. Products supported by this driver include DPA 4, DPA RF, DPA III Plus, and the DPA 4 Plus. |
| DPA4PSA      | B      | DPA 4 Plus Variants (Single Application)  
              |        | Allows only one RP1210 application to run at a time. |
| DPA4PMA      | B      | DPA 4 Plus Variants (Multiple Application)  
              |        | Allows more than one RP1210 application to run at a time. |
| DGDP5SA      | B      | DPA 5 Variants (Single Application)  
              |        | Allows only one RP1210 application to run at a time. |
| DGDP5MA      | B      | DPA 5 Variants (Multiple Application)  
              |        | Allows more than one RP1210 application to run at a time. |

The **DPA 5 Bluetooth Configuration Utility** button will only be available if a DPA 5 API is selected.
10.2. Set Options for DPA Device/API

When selecting DPA Options from the program menu of an installed DPA driver set, the program should default this field to that particular DPA driver set. Note that you can only modify driver sets that have been installed.

If you want to modify an option for any DPA driver set, you select that DPA driver set with this field.

10.3. J1939 Fast Transport Layer (FAST_TRANSPORT Option)

When this option is in the On (Default) position, it significantly decreases reprogramming and reflashing times over the J1939 data bus by reducing the amount of time between J1939 transport protocol (TP) packets (used to break large messages into CAN 8-byte packets for transmitting on the data bus). With this option turned on, however, some PC applications and vehicle controllers may not be able to keep up with the DPA.

This option has long existed, and many OEM and component manufacturers using the DPA for end of line (EOL) programming stations have used it successfully. If you encounter a diagnostic or reprogramming/reflashing application that is having problems with the DPA using the J1939 protocol, we recommend setting this parameter temporarily to the Off position and then retrying the application.

This parameter makes little, if any, difference during standard diagnostic sessions.

10.4. Debug Logging Level (RP1210B INI Option DebugLevel)

This is an RP1210B introduced INI file option designed to record vehicle data bus data and other pertinent driver data to a text file. Chances are you will never need to use this, DebugFile, DebugFileSize, and DebugMode options unless you are directed by an OEM or Dearborn Group to investigate possible software issues. Potential values for this option are:

0 = No Debugging to be Accomplished (Default).
1 = Only Connect/Disconnect/Error Messages.
2 = Add RP1210_SendCommand Calls.
3 = Add all Sent Messages (with Filtering).
4 = Add all Received Messages (with Filtering).

Changing this value to something besides 0 (the default) will cause the DPA drivers to start logging DPA driver and vehicle data bus data to the DebugFile based on the selected value.

10.5. Debug File Name (RP1210B INI Option DebugFile)

When DebugLevel is on (1-4), this is the file that will receive the data logging output in text format. This file is in ASCII and can be read using a text editor. The default value for this option is in the Windows temporary directory, with a filename appropriate for the driver set.

10.6. Debug File Size (RP1210B INI Option DebugFileSize)

When DebugLevel is on (1-4), this is how large the DebugFile can grow in bytes. The formula is (DebugFileSize * 1024), so if you want to allow the DebugFileName the ability to grow to 2 megabytes, you would set this value to 2048. The default value for this parameter is 1024, or 1 megabyte.
10.7. **Debug File Mode (RP1210B INI Option DebugMode)**

When *DebugLevel* is on (1-4) and this option is in the 1 (Default) position, the DPA drivers will append data to *DebugFile* (which could have data from previous logging) until it reaches the end of the file (1024 * *DebugFileSize*). When reaching the end of the file, the DPA drivers will erase *DebugFile* and start writing new data to the file.

When *DebugLevel* is on and this option is in the 0 (Overwrite File Contents) position, the DPA drivers will erase *DebugFile* and begin writing data to the file until it reaches the end of the file (1024 * *DebugFileSize*). When reaching the end of the file, the DPA drivers will erase *DebugFile* and start writing new data to the file.

10.8. **Automatic Firmware Update**

Setting the variable *Automatic Firmware Update* to the *Value* causes the drivers to exhibit the behavior in the *Action* column.

<table>
<thead>
<tr>
<th>Value</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Automatic firmware update is turned off. No automatic checking for new firmware.</td>
</tr>
<tr>
<td>1</td>
<td>Automatic firmware update is turned on. The user has a choice as to whether or not to upgrade. <img src="image1" alt="Automatic Firmware Update" /> If the user selects Yes, the firmware is automatically updated. If the user chooses No, then the drivers connect the application to the vehicle. This is the default.</td>
</tr>
<tr>
<td>2</td>
<td>Automatic firmware checking is turned on. The user is only told that there is new firmware available and told they should run the DPA Firmware Updater. <img src="image2" alt="Automatic Firmware Update" /> When the user chooses OK, then the drivers connect the application to the vehicle. The user can then update the DPA at their convenience.</td>
</tr>
<tr>
<td>3</td>
<td>Automatic firmware update is turned on. The user is told there is new firmware and the firmware is downloaded automatically as soon as they press the OK button. <img src="image3" alt="Automatic Firmware Update" /> When the user selects OK, the firmware is automatically updated.</td>
</tr>
</tbody>
</table>
10.8.1. When the Drivers Call the DPA Firmware Updater

In the event that the automatic update is chosen, the DPA drivers launch the DPA Firmware Updater, which handles the downloading of new firmware. Once the firmware has started downloading, the user should not stop it. Aborting a firmware download may cause the device to become unresponsive and require the hardware to be shipped back to the manufacture for repair. The following is the dialog box showing the DPA Firmware Updater during an automatic update:

When the update is complete, the following dialog box is displayed and the DPA drivers attempt to let the application that was suspended continue executing. Most applications can handle the interruption; however there is a possibility that the user may have to restart their application.

10.9. DPA 5 Bluetooth Configuration Utility

This button opens the DPA 5 Bluetooth Configuration Utility. This allows the user to create RP1210 DeviceID entries from DPA 5 Bluetooth Pairings. This utility has its own help file.
11. Running the Bluetooth Configuration Utility

After you have successfully paired your DPA 5 with the Bluetooth dongle and have created the *Virtual COM Port*, run the DG Bluetooth Configuration Utility to create an RP1210 DeviceID entry that can be seen by OEM software applications:

- Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ DPA Options

You must go through this configuration utility to create RP1210 DeviceID entries. If you do not, the DPA 5 in Bluetooth mode will not work with your OEM applications!

What the DG Bluetooth Configuration Utility does is:

- Display existing DPA 5 Bluetooth RP1210 DeviceID pairings that are found in the DGDPA5SA.INI file, allowing you to delete an RP1210 DeviceID pairing if you wish.

- Discover DPA 5 Bluetooth devices on Virtual COM Ports and create a new RP1210 DeviceID pairing that can be used by OEM software applications.

Note: The DPA 5 must have power in order to create the Virtual COM Port and RP1210 DeviceID pairing.
11.1. Creating a New RP1210 DeviceID from a Newly Paired DPA 5

After you have paired a DPA 5 with your PC and created a Virtual COM Port, click the Discover Bluetooth DPAs button. Any Bluetooth DPAs that you have paired with will be automatically added to the DGDPA5SA.INI file. OEM applications will now be able to see and use that particular DPA 5 as RP1210 DeviceID=160.

NOTE: Sometimes the detection process through the virtual COM port does not see the DPA on the first attempt. If this is the case, try the discovery process again.

11.2. Deleting an RP1210 DeviceID

If you want to delete an RP1210 DeviceID, simply select that entry and click the Delete Pairing from DGDPA5SA.INI file. Note that after the RP1210 DeviceID has been deleted, it will NOT appear in OEM software applications for selection. For information on Bluetooth (including FCC and IC identification), see the Bluetooth Configuration Manual. It can be found in the Windows Start Menu.
12. Product Specifications

12.1. DPA 5 Physical and Electrical

<table>
<thead>
<tr>
<th>Feature</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>6.1 x 2.5 x 1.2 inches</td>
</tr>
<tr>
<td>Voltage Requirements</td>
<td>9 – 32 Volts DC</td>
</tr>
<tr>
<td>Current Requirements</td>
<td>250mA maximum through voltage range</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>-40 to +85°C</td>
</tr>
<tr>
<td>Wired PC Communications Type</td>
<td>USB Version 1.1 or Higher</td>
</tr>
<tr>
<td>Wired Connection</td>
<td>Gold-plated USB Cable (up to 15 feet)</td>
</tr>
<tr>
<td>Wireless Connection</td>
<td>Bluetooth (DPA 5 Dual-CAN is equipped with Class 1 radio)</td>
</tr>
<tr>
<td>Vehicle-Side Connector</td>
<td>DB25 Female</td>
</tr>
<tr>
<td>PC-Side Connector</td>
<td>Standard B-Type USB Jack</td>
</tr>
<tr>
<td>PC Device Drivers</td>
<td>TMC RP1210A/RP1210B Compliant Drivers</td>
</tr>
<tr>
<td></td>
<td>DG Native Drivers</td>
</tr>
</tbody>
</table>

12.2. DPA 5 Pinouts

<table>
<thead>
<tr>
<th>Signal</th>
<th>DPA 5 Dual CAN/BT</th>
<th>DPA 5 Quad CAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Power (9-32vdc)</td>
<td><strong>8</strong></td>
<td><strong>8</strong></td>
</tr>
<tr>
<td>J1708-</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>J1708+</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>CAN1 Shield</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>CAN1 Lo</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>CAN1 Hi</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>CAN1 Term 1</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>CAN1 Term 2</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>CAN TX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN RX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SW CAN</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>ALDL/GM UART</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>ALDL RX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9141 K Line</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>9141 L Line</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>J1850 Hi</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>J1850 Lo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ATEC Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ATEC Diag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discrete In</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discrete Out</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN2 Term 1</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>CAN2 Term 2</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td>CAN2 Shield</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>CAN2 Lo</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>CAN2 Hi</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>LIN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HALDEX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN3 Lo</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CAN3 Hi</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>CAN3 Shield</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>CAN4 Lo</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>CAN4 Hi</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CAN4 Shield</td>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>

* Shunting these two pins (Term1/Term2) applies a 120-Ohm terminating resistor to the CAN/J1939 network.
* Pins that are not mentioned are reserved and should not have anything attached to them.
13. DG Update – Program Overview

DG Update is an application that is installed with your DPA drivers. It will run (by default) once every 30 days, and will keep you up-to-date with the latest versions of drivers for all your DPA, DG Diagnostics, and VSI-2534 products. With this application running regularly and Automatic Firmware Update (see DPA user manual) turned on, this will keep your DPAs up-to-date with drivers and firmware. DG recommends our customers keep up-to-date so that your OEM and component manufacturer diagnostic applications run smoothly.

The utility will run once every 30 days as a user logs on. This value is configurable, but defaults to 30 days. It can also be invoked manually from the Windows Start Menu:

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ DG Update

13.1. DG Driver Update – Internet Connection Required

The DG Driver Update utility depends on successfully connecting to the Internet (to one of DG’s servers) to retrieve the latest version information and to download the latest drivers and applications if necessary.

Many companies install firewalls and virus protection and these may block the DG server queries and responses. If you are connected to the Internet and have issues running DG Update (getting “Unable to connect to the internet to check for updates.” messages), ensure that your firewall or virus protection will allow a connection to the following Internet host/site and port: fh.dtech.com, port 8888. There are too many firewall and virus programs on the market to cover in this manual, however if you contact your network administrator and give him the host and port number, he should be able to configure your PC to allow the communication. You may also consult the Windows help system and/or the documentation for your firewall and/or virus protection software.

13.2. DG Driver Update – Initial Screen

When the utility runs as a user logs on, the following screen will appear in the lower right hand corner of the screen. If you want to check for updates, ensure that your PC is connected to the Internet and click Continue. Clicking Cancel will cause DG Update to wait until the next time it is scheduled to run. Clicking Continue will bring up the main update screen.
13.3. DG Driver Update – Main Update Screen

The main screen appears looking like this. Depending on which products are installed on your PC, the grid will display pertinent information about them. When selecting DG Update from the Windows Start Menu, this is the first screen to appear.

Connect your PC to the Internet and click the **Check For Updates** button. Due to the nature of TCP/IP communications, errors connecting or sending/receiving of data are slow to appear, however the user will eventually be notified if there was a problem.

If the check for updates was successful, the second column of the grid will display information returned from the DG server showing the most current versions and the **Install Status** row will change to red, green or blue.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Drivers up-to-date. No update necessary.</td>
</tr>
<tr>
<td>Red</td>
<td>Drivers are outdated. Update recommended.</td>
</tr>
<tr>
<td>Blue</td>
<td>Drivers on your PC are newer than current version.</td>
</tr>
<tr>
<td></td>
<td>This usually indicates you are running a beta copy of the DPA drivers.</td>
</tr>
</tbody>
</table>

13.3.1. Successful Connect – No Updates Available

In this case, all drivers are current (green), and the **Download** button and progress bar do not display (see next paragraph). Clicking **Exit** will exit the program.
13.3.2. Successful Connect – Updates Available

In this case, the DPA 5 drivers are out of date (red), and the **Download** button and progress bar show up on the screen. The progress bar will keep you informed of the download progress should you choose to download the latest drivers by clicking the **Download** button.

When you click the **Download** button, you will be prompted to confirm starting of the download.

Note: The DG Update application can only download and install one item at a time. The user will be prompted for whichever one they want to update first. The reason that only one can be downloaded at a time is that the after the drivers are unzipped the installation program begins automatically. The DG Update program must exit because the installation program may have a newer version of the DG Driver Update utility to install.

After choosing **Yes**, the program will download the drivers and update the progress bar while doing so. Once the drivers have been downloaded, the application will unzip them and start the installation process. The dialog box will go away after the install has been started.

After the drivers have been downloaded (to the Windows temp directory – if you wish to save them for other machines), they will be unzipped and the program will exit right after starting the new driver installation. Follow the installation instructions in the appropriate User Manual.
13.4. Advanced Settings – Setting Default Time for Check for Updates

If you want to turn off, or alter the timeout period where the user is prompted to check for updates (the dialog below), press the Advanced Settings button.

The following dialog box will be displayed. To turn off the checking prompt, set the value to zero. Otherwise, you can set the number of days between checks.
14. Technical Support and Return Merchandise Authorization (RMA)

14.1. Technical Support

After reading and following the troubleshooting and validation procedures in Chapter 8 and not being able to resolve an issue, please feel free to contact DG technical support. For users in the United States, technical support is available from 9 a.m. to 5 p.m. Eastern Time. You may also fax or e-mail your questions to us. For prompt assistance, please include your voice telephone number.

Users not residing in the United States should contact your local Dearborn Group representative.

DG Technologies Technical Support

Phone: (248) 888-2000  
Fax: (248) 888-1188  
E-mail: techsupp@dgtech.com  
Web site: www.dgtech.com

14.2. Return Merchandise Authorization (RMA)

If technical support has deemed that there may be a physical problem with your DPA, you will be issued you an RMA number. You would then return the product along with any documentation of ownership you have (proof of purchase/price) to the following address:

Product Service/Repairs  
Attn: RMA# xxxxxxx  
DG Technologies  
33604 West 8 Mile Road  
Farmington Hills, MI  48335
15. Warranty Information and Limitation Statements

15.1. Warranty Information

The Dearborn Group, Inc. DPA 5 is warranted against defects in materials and workmanship for two (2) years following date of shipment. Cables (both USB and vehicle) are warranted for 90 days.

Dearborn Group, Inc. will, at its option, repair or replace, at no cost to the customer, products which prove to be defective during the warranty period, provided the defect or failure is not due to misuse, abuse, or alteration of the product. The customer is responsible for shipment of the defective product to DG. This warranty does not cover damage to any item that Dearborn Group, Inc. determines has been damaged by the customer's abuse, misuse, negligence, improper assembly, modification, or operation of the product.

A Return Merchandise Authorization (RMA) number must be issued to the customer by our Technical Support Department at (248) 888-2000 and must be included with the product being returned (for more details, see section Return Merchandise Authorization (RMA)). A DPA is warranted for 90 days after a warranty repair, or to end of the original factory warranty period, whichever is longer.

15.2. Limitation Statements

15.2.1. General Limitation and Risk Assignment

To the maximum extent permitted by applicable law, Dearborn Group, Inc. and its suppliers provide support services on an “as-is” basis and disclaim all other warranties and conditions not specifically stated herein, whether express, implied or statutory, including, but not limited to, any warranties of merchantability or fitness for a particular purpose, lack of viruses, accuracy or completeness of responses, results, lack of negligence or lack of workmanlike effort, and correspondence to description. The user assumes the entire risk arising out of the use or performance of the device, its operating system components, and any support services.

15.2.2. Exclusion of Incidental, Consequential and Certain Other Damages

To the maximum extent permitted by applicable law, in no event shall Dearborn Group, Inc. or its suppliers be liable for any special, incidental, indirect or consequential damages whatsoever, including but not limited to: damages for loss of profit, loss of confidential or other information; business interruption; personal injury; loss of privacy, failure to meet any duty (including good faith or of reasonable care); negligence; and any other pecuniary or other loss related to the use of or the inability to use the device, components or support services or the provision of or failure to provide support services or otherwise in connection with any provision, even if Dearborn Group, Inc. or any supplier has been advised of the possibility of such damages.

15.2.3. Limitation of Liability and Remedies

Notwithstanding any damages that you might incur for any reason whatsoever (including, without limitation, all damages referenced above and all direct or general damages), in no event shall the liability of Dearborn Group, Inc. and any of its suppliers exceed the price paid for the device. The user assumes the entire risk and liability from the use of this device.

15.2.4. Right to Revise or Update without Notice

Dearborn Group, Inc. reserves the right to revise or update its products, software and/or any or all documentation without obligation to notify any individual or entity.

15.2.5. Governance

The user agrees to be governed by the laws of the State of Michigan, USA, and consents to the jurisdiction of the state court of Michigan in all disputes arising out of or relating to the use of this device.

15.2.6. Contact

Please direct all inquiries to:

Dearborn Group, Inc.
33604 West 8 Mile Road
Farmington Hills, MI 48335
Phone (248) 888-2000
Fax (248) 888-1188

Even though automatic firmware update comes defaulted to on, there may be a time you need to update your DPA firmware manually. The first step in a manual firmware update is to find which version of firmware you have. You can use the AVT utility after connecting the DPA to a power source.

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ Adapter Validation Tool

Select the correct DPA adapter:

- **Vendor** DGDPA5SA – Dearborn Group DPA 5 Single Application
- **Device** 1 – DG DPA 5 Dual-CAN USB - USB
- **Protocol** J1708 (any protocol works)

Then click the **Run Test** button. When the test has finished running, go to the **RP1210 Status Window** and scroll down to the line that reads [RP1210_ReadDetailedVersion] and look for the entry “FW=”. The last numbers on the line indicates which version of firmware you have (note the yellow circle). If you are not at the correct level (see manual cover page for which version you should be at), then you need to run the DPA Flash Updater outlined in the following steps.
16.1. **Launch the DPA Flash Updater Program**

1. Stop all applications that are using the DPA 5 (if any).

2. Start the DPA Flash Updater program:

   ![DPA Flash Updater Program](image)

   - **Start** ➔ **Programs** ➔ **Dearborn Group Products** ➔ **DPA 5** ➔ **DPA Flash Updater**

3. Select the correct firmware file (the latest version is already selected by default). If the firmware file exists, the Firmware box will turn green.
   
   a. **NOTE:** Firmware files are located in separate sub-directories under the Utilities directory where the DPA drivers are installed, typically:

   ```
   C:\Program Files\Dearborn Group Products\DPA 5\Utilities\DPA5_Firmware\DPA5_Firmware
   ```

4. Click on the **Update Firmware** button and select **Yes** if you receive a warning dialog.

5. After the download is finished, disconnect power from the DPA, wait 5 seconds and then reconnect power.
17. Appendix B – Software Developer/Integrator Notes

This section is relevant only to software development engineers and systems integrators.

17.1. Bundling the DPA with Your OEM Installation – Silent Install

The installation application can be run in "silent mode" which removes all required user interaction.

- The silent installation does not prompt the user or display a screen at any point.
- After the install, a reboot of the PC is necessary.

17.1.1. Silent Install Command Line

DPA5Install.exe /s /d_SILENT_=[components to install]

The [components to install] can be any combination of the following:

A = DG DPA 5 Dual CAN USB drivers and associated files
B = DPA 5 Bluetooth drivers and associated files
C = DG DPA 5 Quad CAN USB drivers and associated files

Examples:

Silently install DPA 5 drivers with Bluetooth Option:
DPA5Install.exe /s /d_SILENT_=AB

NOTE: Please test and ensure that the command line you provide to DPA4Install.exe is correct. Otherwise, only the baseline components will be installed, but the RP1210 API will not be functional.

17.1.2. Controlling Automatic Firmware Update Variable on Silent Install

If you are a software development engineer or system integrator and wish to use the silent installation, but you want to change the Automatic Firmware Update setting to a value other than "1" (default), you can do so by changing the registry value of the following variable during a post-installation event.

DPA 4 Plus (DG121032)

HKEY_LOCAL_MACHINE\SOFTWARE\Dearborn Group Technology Group Products\FirmwareUpdater\UpdateFirmware

DPA 4P (DPA4PSA, DPA4PMA)

HKEY_LOCAL_MACHINE\SOFTWARE\Dearborn Group Products\FirmwareUpdaterDPA4P\UpdateFirmware

DPA 5 (DGDPA5SA, DGDPA5MA)

HKEY_LOCAL_MACHINE\SOFTWARE\Dearborn Group Products\FirmwareUpdaterDPA5\UpdateFirmware

This variable is of the REG_SZ data type, however only the first character ('0','1','2','3') is used by the DPA Options program and the DPA drivers.
18. Appendix C – FCC and Certification Industry Canada Information

The DPA 5 has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules (see the back of the DPA 5 for FCC and IC specific identifications). These limits are designed to provide reasonable protection against harmful interference in a residential installation. The DPA 5 uses and generates radio frequency energy. If not installed and used in accordance with the instructions, it may cause harmful interference to radio communications. If the DPA 5 does cause harmful interference to radio or television reception, which can be determined by turning the affected equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving and/or sending antennas.
- Increase the separation between the DPA 5 and the affected receiving equipment.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This product complies with FCC OET Bulletin 65 radiation exposure limits set forth for an uncontrolled environment.

18.1. Industry Canada

Operation of the DPA 5 is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Changes not expressly approved by Dearborn Group, Inc. to the DPA 5 could void the user's authority to operate the DPA 5. The following is a sample rear label from the DPA 5 depicting the FCC and IC identifiers.

![Sample rear label from the DPA 5](image)

The following are the DPA 5 Bluetooth details as required to be published by the FCC.

<table>
<thead>
<tr>
<th>Operating Frequency</th>
<th>2.4GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Output Maximum</td>
<td>&lt; 4.4dBi</td>
</tr>
<tr>
<td>Contains Transmitter Module FCC ID</td>
<td>QOQWT11</td>
</tr>
<tr>
<td>Transmitter Bluetooth QDID</td>
<td>B012647</td>
</tr>
</tbody>
</table>
Microsoft® has made great strides in updating their operating systems to protect against malicious software. With Windows Vista, Microsoft introduced User Account Control (UAC). UAC strictly enforces the differences between an administrator and a standard user account. When an action that could potentially compromise the PC such as writing files to the C:\Windows directory or registry is requested, the user is prompted for an administrator name and password. If the user is already an administrator, they are still prompted to confirm the action. Generally speaking, whenever you see the Microsoft security shield 🛡️ icon on a button, you will need an administrator’s password to perform that operation.

19.1. UAC and the TMC RP1210 Standard

Before Windows Vista, it was common for applications to put INI and other types of configuration files in the default Windows directory, typically C:\Windows. The RP1210A standard requires that the RP121032.INI file be located in this directory, along with all of the vendor INI files. On Windows Vista, this means that a standard user cannot make changes to the main RP121032.INI file, nor can they make changes to the vendor INI files when UAC is enabled.

19.2. UAC and the Dearborn Group Adapter Validation Tool (AVT)

A standard user will be able to run the AVT program and troubleshoot the PC-DPA-vehicle connection, but will not be able to fix a problem in the RP121032.INI file without an administrator password (see section on troubleshooting later in this document). The graphic below is from the Adapter Validation Tool (AVT), showing the Microsoft security shield on the Fix/Change RP121032.INI File button.

19.3. UAC Requirements for All DPA Utility Programs

The DPA utility programs (listed below) have been modified to conform to UAC. The following list shows these programs and privileges required to run them:

<table>
<thead>
<tr>
<th>Program</th>
<th>Privileges Required</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter Validation Tool (AVT)</td>
<td>Standard User</td>
<td>Administrator needed for Fix/Change RP121032.INI File.</td>
</tr>
<tr>
<td>DPA Options</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>DG Diagnostics</td>
<td>Standard User</td>
<td>Cannot save/record data bus files to a protected directory.</td>
</tr>
<tr>
<td>DPA Firmware Updater</td>
<td>Standard User</td>
<td></td>
</tr>
<tr>
<td>Sample Source Code</td>
<td>Standard User</td>
<td></td>
</tr>
<tr>
<td>Bluetooth Configuration</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>DG Update</td>
<td>Standard User</td>
<td>Standard user can use program but install of new drivers will prompt the user for the administrator password.</td>
</tr>
</tbody>
</table>

19.4. More Information on UAC

For more detailed information on UAC, there is a helpful article at http://www.wikipedia.org or you can go directly to the Microsoft website http://www.microsoft.com and search for “UAC”.
20. Appendix E – DPA Utilities Version Information for This Release

The DPA utility applications (i.e. AVT, DGD, DPA Options) are common amongst all DPA products and have been split into their own release called **DPA Utilities**. This allows DG to distribute changes to these applications without having to release a new DPA DLL for every API (i.e. DGDPASA, DG121032). Since DG Update looks for this separate installation, it handles downloads and updates to the utility applications.

The version of DPA Utilities installed with this DPA API included:

<table>
<thead>
<tr>
<th>Utility</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter Validation Tool (AVT)</td>
<td>2.4</td>
</tr>
<tr>
<td>DG Diagnostics</td>
<td>2.73</td>
</tr>
<tr>
<td>DG Updater</td>
<td>1.50</td>
</tr>
<tr>
<td>DPA Firmware Updater</td>
<td>5.1</td>
</tr>
<tr>
<td>DPA Options</td>
<td>2.3</td>
</tr>
<tr>
<td>DPA 5 Bluetooth Configuration Utility</td>
<td>1.4</td>
</tr>
<tr>
<td>Sample Source Code/EXE</td>
<td>2.61</td>
</tr>
<tr>
<td>FixINI</td>
<td>2.4</td>
</tr>
</tbody>
</table>
### 21. Appendix F – List of Acronyms Used in this Document

Various acronyms have been used throughout this document.

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>AVT</td>
<td>Adapter Validation Tool</td>
</tr>
<tr>
<td>CAN</td>
<td>Controller Area Network</td>
</tr>
<tr>
<td>CD</td>
<td>Compact Disk</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Compact Disk - Read Only Memory</td>
</tr>
<tr>
<td>DG</td>
<td>Dearborn Group</td>
</tr>
<tr>
<td>DPA</td>
<td>Dearborn Protocol Adapter</td>
</tr>
<tr>
<td>DTC</td>
<td>Diagnostic Trouble Codes</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>ISO</td>
<td>International Standards Organization</td>
</tr>
<tr>
<td>JVT</td>
<td>J2534 Validation Tool</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>OBD</td>
<td>On Board Diagnostics</td>
</tr>
<tr>
<td>OEM</td>
<td>Original Equipment Manufacturer</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RP</td>
<td>Recommended Practice (see TMC)</td>
</tr>
<tr>
<td>SAE</td>
<td>Society of Automotive Engineers</td>
</tr>
<tr>
<td>TMC</td>
<td>Technology and Maintenance Council</td>
</tr>
<tr>
<td>UAC</td>
<td>User Account Control</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VDA</td>
<td>Vehicle Datalink Adapter</td>
</tr>
</tbody>
</table>